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<Confirm>& =] BA vlolEeE At

"Storing data on probe, please wait..."®} "Updating GLP
data, please wait..."HA|Z] 7} YEPE YT
Note: EC BA4o] 2735#] ¢kom, <Skip>
AvHy.

3 "Conductivity" 4] ZHbA g 7]

AL ET

]e =
Dt ETE

"Empty the beaker. Shake the probe and put it in the
beaker again" WA X7} YERE YT}
B HAE 3 &4 AAZ U
ZRBE AXAT7] flal] A2A @
DOAA A Ege] ot Fols
Note: T2HE HAZX3s}7] ¢
] g o AA 7L

H & oL
By HAE
sh o

=o]

=2 e A nAFY.

FAE WAAE 2oH <OK>E FEAA L.
HgstE W, "Ready" WlAIAI7F HYERE U
<Confirm>& =] BA vlolgE A4t

"Storing data on probe, please wait..."¢} "Updating GLP
SHAA 7E YR U

data, please wait..

+ 3-olol®l w4 Hwlo] thal vhehba wg FBol Fgeh
iﬂﬂ tﬂ-/\7}_ E}\]E] 74011/]1;}

« <OK>E =¢] "Calibration" "7 2 Sobtyt},

Note: W& B4 Hdx5 FdstEW AAEA ESCE FEHA L

pH XA

53] & 4957 8= A5, pH SAHAE S8 A5 717

BAst= AS AFFYUH

pH ®Ao] Aed wf, spwde] F 7p4] FAH& HolFHth

"Calibration pH"¢} "Clear old calibration".

"Calibrate pH"7} A€ s A5, AF8A7F 1, 2, 3 EZAEA

%3 ¥ (pH 4.01, 6,86, 7.01, 9.18, 10.0DE & 9&

HEE A3 B4 A BAS 78 & AdFHh
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"pH sensor not installed! Skip to conductivity calibration"

-

A,

24 71717} EC whe

| A1 A 7}

= (uick calibration —

e\ [/ /7, "

[unduttlwtg— O

7| Dissolved nm}gen O
Ready

A}

4

=4 WE DO WAL

= Juick calibration —

Empty the beaker. Shake
the probe and put itin
the beaker again.

-

— Quick calibyation—

pH i
Conductivity b
Dissolvead oxygen O

Calibration completed
u

-

e pl Caliby akion =——

Calibrate pH

Clear old calibration




1

R

"Clear old calibration"o] A1 €l%]

dolEl 7l A AU

Note: pH AA 7} wAld wejeh 22ja A3 dap 8 & o BA dlo]E 7} AkA| ¥ ofof
FuUrth 3-¥9E wAo] F3E uj, BE oA dolgr}t F5 AU 1 &
2-XQE HAAE MRSk B 717I7F w3 ERIES f8) A 3-EQE B
7 o]l A7E HeolHE AFEE AU

=H

Aeel My §AES e vA e A2 S BEUT WA L9S HAskskr] s 7

Hu golof HA F INE AFESHAIL: A=E Al A A%k g g, BAS fgk & ),

e )

SEA ghol - 3ol vehte 9k @Al 49 gtol W<l | —— phcalibration —

3l w iy}, 6.97”'

I QA <Buffer> 22X E7|E w8 WY g AU 2&E Buffear: pH7.01

HHE Addy Mot ready...

F sutter |

1, 2 L& 3-F¥9/E XY

« ZRHE Ay vyl gaa s AojsUh AR TS

oH 7 W7 25 "Not ready’7} o] w1, — pH calibration

I I P ied - e e I A R B oo | A | I s e B 6+97P“

sl o] "Ready"™I Al A 7} Hei T}, Buffep: ; :I‘Ii".m
5 = 293793 : o = &a
PO USRS TEI Confind & AN TR o T
W32 Aess] 98 saEs]E AHEte] <Buffer>2
e A
« A HA B FOEV gAY F s T Hx vy S doia HH3I
Aol F Ut

« SAATE kAStE I dEE HE o 7w shHo] "Ready"H A AIZF BYH

« <Confirm><& Ed] ¥EES 4834} <Buffer>E ¢ WS vy}

 F A B ¥JAEV FAHE T 22 s A HA By g G SHX I}

45 Wi AHe Aol

-

HAo]l ekx ¥ s thg wAIA] 7} 24Ut} "Storing data on probe, please

wait...", "Updating GLP data, please wait..."®} "Calibration completed".

"Calibration" HWF 2 Zol717] 98] <OK>E FE2AA S,
ol w72 EolrtEw ESCE whEd oz FHuyth

= w71 71—

Wi oA Hy

HI 98282 43k vt W gto=w HAsy] 98 4=

¥RIE HAE &g

e o] FAL MEsed A HA <Buffer>Z F23 7]17)7}
SAH X7 A zE wi7b+] 7= 9 <Custom>7|E
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-

= Select cal. buffey ——
pH 6.86

pH 7.01
pHO.18

pH 10.01
| _Custom | 0K |

-




FEAAL.
C s WE G 4S8l B v o) tEhd AYUth RE Al
FES WS 0.00914 14.00pHY Ik,

g g£E
71717F pH BA ¥JES 8384 dow, 7Fed dle] 7Feds 7hel7ls &2 wA A7}
she] Byt ta s g2 oE BN L

pH calibration pH calibration
pH pH
5.19 D.69
Euffer: pH7T.01 Euffer: pH7T.01
Wrong buffer Contaminated buffer

LN A

pH calibr ation pH calibration
pH pH
5.69 5.69
Buffer: pHT.01 Buffer: pHYT.01
Check elactkrode Clean electrode

7hs HIAIAL

» "Input out of scale": 7& %ol 9= pH 3t

« "Wrong buffer": pH SAX|7} dej¥ WH gozry vf HJuoh ¢ut2 B4 A7}
AEAE] =% A Q.

» "Invalid temperature": W3 %7} 385 W ©dych

» "Wrong buffer"/"Contaminated buffer"/'Check electrode": BW]¥ 7} QA EH A A} HA=Fo]
7R AY vg- BEE Y

» "Wrong electrode"/"Check electrode"/"Clean electrode": A =o] W7 A w9

E=Eeani=g

"Wrong"/"Clear old calibration": Z%% &£ =23 Ae]. A<} o]d HA Alo]d &R

ato) 7 E232 AE9-(80%N 4 110%)E d=thd o] HAIA7F YeEbdY T

Clear>AXE7]E = old HlolHE FHAstal By HaE A &st7v ESCE =9 pH

BAY Res Fughych

L= AA BA
¥3} DO% W7 RAEW, DO v WYL £& 1 9
323} DO% #kel &7] +(100%)°] DO & by

o
rf

o
i
=
N
i

&:l

g2 Ayt

&:l

3o Mg Z2BEE BAT AL AL

Z3F DO%, <%, 959} 7)¢te] 7]HES F DO 5 #S HoJFAAL. B3 89 A&
52 HAFE o HXE vud ¥5 DO vEHE AFFgY

Z3} DO% HYY AL 1 28 2 T+ ZAEO%Y 100%)04 T AF 2w ¥0E



(50014 500914 =82 = AFU
DO 5% Weo BAL AF @F FAEMUNA 50mg/L)olA 3= = JdHUTh
"Calibration" wlrolA "DO calibration"& 1211
AE7E AHEE DO B 8BS A9d ¥, <0OK>Z =9 | D0 concentration
g
i | 0K
¥3 DO % :
UEE A HMH B ¥RJAEE 100%Y YT} ( . E vl
g HAS G2 AmmALS] ZEE A9 Lo -Ill]a".saluratmntallllrr.-
AR 1 g, 0.0
o St E ZAHX7F gobE 7% "Not ready..."H A A7} Paint: 100%
3o By Hot ready...
« B4 s WAske ¥ <Cal. point> AZEZ|E FEIL ¥ Cal. point |
ks TUEES Adsty AL, ; j
e T2 BA kS dHEHstyd <Cal. point>¢F <Custom>< = D0 % satuy ation calibr, -
FEAAL, IRES Agd Ashs g dgstae, | B0%4saturation
S QUHL o “Reacy' A A7) el e, [00.0 ,
<Confim>% =t B4 EJEE AAg ) 030.0...500.0°%
R L R 40157} Sy & MEHE A2 AbA I
#F g0 Wn SHA7 ARHAHES Ay J
« <Confirm>% = A ¥QJEE 12]-5qu

Note: AM&A= EF %koi A x
A A 3

e

GLP data, please wait...
<OK>E

| ¢l

AYt}: "Storing data on probe,
"¢} "Calibration completed".
=7 "Calibration" W= Zolu ).

w2 Zol7br] 918 ESCE wHEH o' FEA4A] Q.

WA 7 e A

NQIEV) 8% &

input" MAIA]7F YEREY T

data, please wait...

'Storing data on probe, please wait...",
"9} "Calibration completed" WA]A|7} YERS ] H o] gz}

DO &%=
DO % HE BASH] 98] €8x DO 5% #e &do]

483yt

» "DO calibration" ®|¥7°lA "DO concentration"&4 <
/\%EHO}J_ E:]x] %k,q 013:10}—/ <OK>E EA])\]O

s SAX7} kA E w, 2 7S 8387 ¢ <Confirm>S
=2 AAQ.

b

n

"Updating GLP

"Calibration" "Wl 2 Eo}717] $J8] <OK>E FEAHAL.
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please wait...",

= D0 concentration caliby. -

n

"Updating

D0 concentyation

|[]',|].lll]
04.00...50.00 ppm

i« | 0K |




WQ) iR Eolrbs] flal, BSCE wEAom FaiAL.

AT BA

e MRS w98 TRy Zejnsh AFEe]o i

AEE 1A Wes R4 37H b2 738 28

0] 2= = Lonductivity calibr ation -

A 5YtE Conductivity, Actual conductwlty, Sahmty

= LConduchivit
"Conductivity" &4 A& A8 7hsd 35 &ANO0R Actual cnndcli\ritu

e EJE BAS &Y o] BAL 2% BAPEYT. | |Salinity

"Actual conductivity" FA-2 &HZ AAl (=

HAEA o) wE AL §oow 42 TAE R4S | 0K |

583t

"Salinity" $4& EF 9% 902 BAS LYt

o] Ml 7HA= AdAdo] lerm=m Z}zke] Aaprh A 7hA| W9 B HAZ AUt

Note: B3t EC S8 & #lal, BB SAE A& /e Ak @& 7 55
SN AEste] FalEojof Tt

Conductivity

+ "Conductivity"5A S Ade®sta g4str] & <OK>E FEA4HAL.

CHAS §E ARE G0 -

« ZRHE o] Mo Tl FHA7F kgstE wi7hA] Vb un 22H &£¥HE
Al s oF gt

o § 3P| EFEgko] Heole Bt Wl sfHo] AA SAHAE HoFUTh

il

[« Conductivity calibration - | = Select calibration point - ﬂ
mS5/cm 1413 pS/'cm
1 1-93 5.0 m%/cm
Pain: 1413 pSicm 12.88 mi/cm
Not ready... 80.0 mS/cm
€[ Cal. point J Custom | _OK |

o X5 kS WA W <Cal. point>E FEIL AME 73 XF 3o fAEE 39

BAYth: 0 uS/cm, 84 pS/cm, 1413 pS/cm, 5.00 mS/cm, 12.88 mS/cm,
80.0 mS/cm, 111.8 mS/cm

o I ZH(EE BHAE ZHE fd8€s7] Y8 <Custom>S FEAAL.
s SAX 7} etAHE wl, B golHE AAsH7] Y3 <Confim>S TE4HA L.
« A &t} wA| X7} 3o Byt "Storing data on probe, please wait...",

"Updating GLP data, please wait..."¢} "Calibration completed".
» "Calibration" Hl-7+% Zo}7}7] Y3l <OK>E FEAA L.
c el Wi R Eolrly] 913 ESCE WMEAOR FEAA Q.

Actual Conductivity

« "Actual conductivity" ¥AS AE3al <OK>E w8 4344 L.
« Yote EER 2HE S dEFdYT KOK>E =9 A AL

_18_



- ZRBE AR goo] g ARV Askd WA o fictual cond. calib
Ahgueh, Zen Zelnoh 44 sl gt Netwil canduietivley
- Z4A 7L deka w, 1wy doleE Agstr] 9 [00.000
<Confirm>& =4}/ 2. 000.100...900.000 ms/cm

« A & S HA A7} §}‘34°ﬂ B <Yt} "Storing data on
"Updating GLP data, please
wait..."¢} "Calibration completed".
« "Calibration" "lw=2 Ho}7l&™d <O
« Wl R Fobrbr] 918 ESCE wh

probe, please wait...",

flResolution] OK |

— Yaliraty caliby, ——
Lalinity

[Do.00 |
05.00...70.00

fl & | 0K |

Salinity
« "Salinity" 34 A¥sal <OK>E FHUtHt
« B RA S0 Ak e ?;ﬁa}/}:})\]g
e TRHE HALL g Fa3 SAX 7} orAIE w7
Zltkdunt, 2B Ze a7t 4kl Eofof @qq
« ZA X7} okAstE W, BA dolgE AAsty] 93
<Confirm>& FEAHAL
« 24 5, ds WAATE 3] Btk "Storing data on probe, please wait...",

"Updating GLP data, please wait...'
* "Calibration" ™77 2 Fol7lel¥ <OK>E FEAA L.
L ool Wi R Eol7by] $19) BSCE wEAom FEUT
Note: o] A 23 g WAL oZAg

Exéé}i‘ﬂl‘ﬂ HA ¥RJAEE OuS/cmoll AAsta Axp

BT £ 9ol 31§ Wl0o14 50C)3kel
2} &t "Invalid temperature"H A A 7} 3 o
Bt A=E 4ol 58 Welel A W
"Invalid input"®W Al A7} shH] H Iy,

mlm

E

A

AN

71 HA
o] AatE fs8l % gAY 2oL B
A SAHA7F BA EQJEA 40 mbarZ7HA]
AFH T

"Calibration" "+l 4] "Atmospheric pressure"A<

=0}

RS

Ehas
oE 5

’45”3}"’ UA g7l E ASsE R F3S A9sta

<OK E’ Al }\] O

. UHE i‘ﬂioﬂ/ﬂ o8 BAS Fstr] 9@ "Custom
pressure" &AS AEEAA Q.

s <Unit>712 54
SEESRES

« KOK>E =9 SAHA7F A stE dizb=] 7iohea BA
dlolel & A43st7] 98] <Confirm>& FEAA L.
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'9} "Calibration completed".

-I *93 m3/cm

Foint: 1413 pideme
Invalid input!

i Cal, point

. Conductivity calibyation - \

4

= Pressure calibration —

Restore Factory calibe,

b

s

= Pyessupre caliby ation —
Pressure

[0o.0

150.0...850.0 mmHg
L Unit ] OK |

L

)



HA
"Updating GLP data, please wait..

"Calibration" "7 & Zol7tg ™ <OK>E FEAA L.

T e WA A 7F ] BY Ut "Storing data on probe, please wait...",
"¢} "Calibration completed".

o ol w2 Folrr] 9] ESCE wbEH o= FHUt

o T BAS A AFs7] Yl "Pressure calibration"H ol ASEE SHS
MBI KOK>E FEAA L.

ORP .4

"ORP calibration”ﬂﬂﬂ‘?ﬂ }\o] LRIE 51’% E_Xé —’Fgﬂol‘% DPP calibration =

= ¥
T BA A AAES 58}

"Custom ORP"3A &

S HElsla <OK>E FEAA S
H715 ORP <o AFt
JIHEE AFEE 89 S dFeta IS $8 <KOK>E
_,__«/\1 )\] Q.
=327} A sE u, <Confirm>S E¢] By IAEES
A7y
3 & o WAIX7F g Xyt "Storing data on

" "Updating GLP data, please
wait..."¢} "Calibration completed".

"Calibration""| 772 =o}l7}7] 93] OKE
w2 Zol7eH ESCE WHEd o2

probe, please wait...

YL

T4 BA dole= A A Asew "ORP cahbratlon”UﬂTLrOﬂH &3t

<OK>E FH4th

=5 By

NN e FAAR B

rfo

A=Y

"Calibration” "]+l A "Temperature" 4S5 Aesta
OK>E 31 o Ex% l=R=N-1 q&qq

g2FoM T2HE YT
SA 99T, F Z2 K& 493
o

I=] .

S8 7F kA skE wf "Ready"7F shol vEbH LT
<Confirm>2 o] B ¥JEE AF3}.

44 5 o5 WA A7F shHe] By th "Storing data on
" "Updating GLP data, please
wait..."¢} "Calibration completed".

<OK>E =¢ "Calibration"vl 72 ok},
el wWarE Eolrtr] 98] ESCE WHEA o= ¢

probe, please wait...

E/\l)\]o
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Custom ORP

Restore Factory caliby.

P
— ORP caliby ation ——

= wAo] ofg) AgAH

oRp
[Doooo.0
_EHHUIDHIHEnnnln |'|'I|I'

t gde Aesy
Fae -

=— Temperature ¢ alibr, —
Temperature

[m0-o0 |
=5.00...55.00 *C

L. s

=— | emperature caliby, —

23.25"

Faink: 0.00°C
Hot ready..
| Cal. point |




Note: 71717} @A A X9 A4 3k AloloA] H=E +2T
=, spHo| Ao
HA1A] "Max +/-2TC is allowed"7} Ytk

o2 Pt et w

GPS # ¥

HI 9828 & 12 Ad F8&7]9 A& Aitstar 54 dolHE
ot Y7 W= o] l+= GPS(Global Positioning System) 7]%

A= FAXR o]

GPS ©¢1&= 10 " 91X

o= =

— Temperature calibr. —

25.01°

Paint: £0.00 °C
Max +/-2 °Cis allowed

e} 948 F4
AZF
942 ALgete] 1xE FAFU

=] -
or—

o

=

GPS %742 1070e] SAZE7HA 7 shde] Hojal Zaf dHolH= 7]|5g Yyt
&
iananiw | |sSien, AT
71°28'36.1 71°28'36.1"%  349.7 ORF
E-IE--IEI-E ﬂ.IEﬂ.iJ
GPS A% ke 344 3d 2 8% o}ﬂ% e e 524 BAE E3 sl
BAdYch Zutol= A4 84 shunk welohd, 1F9A EZo] ofF R EXA EAdAY
A& ZFerb kA FUtHe] A5 Als AEE Fol7] f8 AR SAHAAL)
ASATE GPS %4 e 2aE delHR 899 A 242 A ANE AT 5
MHL]E]F f 3
- GPSU|F = Sol7telw 24 mEo A Menuw>E FEI Menu
'GPS menu" S-S MBI 4S9 <OK>E System setup
TS Calibration
GLP data
L HHEAE ALEE Aste fAS stelgels By || AT
COK>E FEAAQ, i 0K H
« GPS 7}5 el E wiAst] 918 <GPS OFF> 52 <GPS /
ON> A E7|7} st B ZdUth 914 dlolE7} 8 75A] &=rvhd, siHE &
ol7]7] 918l GPS 29IAE 114N L.

3 oA

7}s8k 34 All locations, Nearby locations, Clear all

locations, GPS diagnostics.

All locations
o & A} Ao A%
BolFYth GPS ©@$7F Hold

AA=HE A =3 FAEEY

}‘:]O::L

v =2

rkﬁ

_21_

Fa

LPS menu
Hearby locations

Clear all locations

PS5 diagnostics

| GPSOFF | _OK i3

-

B

HIl loCations
Albion Bridge * 1000 ma
Hamlet Bridge *1000 mi
Home test point 45 ft
Yenice 1.0 mi

Ll JHew | Info ;3



AegE 9 x)o ASsl= GPS A4S B7) 93] <Info>E
FEAANL Yxe A AYE AXE 2HAEty] 96|
<Delete>E FEAIA L

EP RS E T R

<8ll, HI 929828 Alg-3te] 3 M)
theuo Ala 7] 7] Hl e 25E

59

Al SIAE EAEE B 2=El] Hatr] A8 New>E F2iL ¢
A 5 7 ARt A F stuE A sk Al & "Current
position to location" <2 "Add location manually".

A A Aol zolA 71717k Eo1717] flE] 1A DRk
LAFYY. v FEARl Fll A ket A BE
Y= olof .

71717F 5078] X744 A = sy

Nearby locations

o] AE T A AAATE AP A A7A
YrEd A ke 9AE BE AL HEFTh A
AAA 2 917 A md wAFE T,

GPS7} FH AL GPS 457 AHE7bsehA e ol

g 2Ex o8 bsstA F5Uth

Wb 9121 307 A ol $1A] 2070744 &2 A
HA o] & 7Hsgk 914 105 3T

1000kmET 6 9 A= 77k Aol 23 A

o,

Mg 91219 GPS 245 B <Info>E FEAHA L

FH 28 E W< Delete>E FEAA L.

o] o1

A—

Note: #1A|7} EA]3H= ZE A3y of

AGUTh 9AE A7) A8 A WA 2E dolHE HI 929828

1

S
“

3134

71717 2R el HaE e

e filbi0N Bridge =——
Latitude 41°57.161'H
Longitude 71°27.128'W

il Delete | 0K &

Locations

Current pos, ba location

Add lecation manually

T

Lecations
Enter location ID

[Blacks{l |

1« | 0K &

w— Hearby locations ——

Blackstone river 3.dmi
Diamond Hill res. 6.0 mi
Arnolds Mill res. 6.2 mi

[l New | _Info _H

A

o} A, A 94

i

o)
i

Aol S AHg-ato]

S
=

XEE

PColl B2 st Al 2. 22fal yA 7]7] Wzegex] 2EE A4 L.

A YAHE &4 g2E 4 New>E FEAAIL. 283 YA F 719 o]&

7Fedt FA 5 & HAE Y

] = 5
location manually".

A WA Ao]zol A 71717k Al IDRF Y= As
F7rl A e A AR W Qg e ofof FTh

4l Al 9 "Current position to location" =< "Add

s Nel

R

e v %

42



Clear all locations PEE—— .
RE YAEZ 2HAls] 98 o] $AL AEshc. o

71717} A=} Aol "All location information will be Il_lllnl:atlnn |nl’nrmi_|l‘mn
will be er ased. Conktinue?

erased. Continue?" HAAE HJozH S A5

A, T Yes | Ho F

AR S A Yes>E FEIL ol d 3 ]

Zol7b7] g8 <No>E FEA4A 9.

Note: oju gt X7} &£ 2EF AFAFTHH, 77]7F AL E 3834 FFUTL

GPS diagnostics

=

o] &Alo] the GPS AKX H7|Z 33Utk A 929 - GPS diagnostics ——
o 97 Latitude 41*59'48.6"N

Fl=st A, A5 Longitude 71°28'36.1"W
At AZHGPS 2152 dA| ol%@ I %M‘ﬁ). Satellites 10
<Locations> a~XE

shdol] Eoizd YU L
<GPS OFF> 22 E7]E F2W GPSE AL m%qq,
<GPS ON> AXE7] 29 GPSE AH&E Boja "
A GPS A7) 2l HHE HolFuyth

e mlm
©

27 B

GPS7F AH&3F 4= sl 749 HI 98282 10071¢] tha ZEe] 60,000 WE7HA AFS 4
AFUTE GPS 7]5& AH-3l ﬂéﬂﬂ AE = A AEe A 5= 4500094 9]
T Bl AdE =

] ©08AD0%  53.73ubkn

=7 8.25pH 43.54;:15;.:111*
- e = 65.43°F 26.86tdspet
=4 mEAAN PRt SAAE AdEEU <Log>E 30.07inHa 355554l
F2AAQ. 41°59'48.6'N 26.4%
71°28'36.1"w 349.70RF
e 71717F MES AAst] 918 ouws A glo] Y EE Log
2EZ ok 7+ MZo g1 gy 7196 Log one sample in:

Lokl
Bro] R0 Bl Aol 99 4 gaTth "

(Ho remark)

- Lape Lod ————

Add lacation?

AAAAT A BE AQI L. AN S Fe
sERY

7S o} SIS H) <Yes>E FEAHA L, H-I_EJ



o] FAL AUHHH No>E FEAA L.

« "SAMPLE LOGGED" WA 7} ®oli A 7]7]7} =4
BER Folghuh

i
o

4
)
ol
1
i
o
JE
o
X
<

101,

lo

N [
tlo
o 4o

o
P
ook

o

N
Iy
i
R
Ru s

el

H <Options>&

[l b

i
o o it (oo

4
>

.
A

One sample>3} <Continuous> A2XE7|7} YERS

Yt} fee gAe AusaAle,

A S Aeety] Slal, SAE 718 Abge) EAshe

s rEANL. R RES
7] 9F <New lot> AXE7|E FE21 J|HES
Agstel Yot mEG UAE ve] Qe
OK>E =8 IgFUL. 2E o]Fo] on EAgty,
A5 #AA7E e,

o 223 YA "Add remark?" 9=57F YEE AJY

2L W
o

T <Yes>E 231 remark©] oju] Ex]gtohbH, AL8-27F Yok

ALY o Hol= BAE HbAd A 2E remarks Y #E3H7] 938 <New

AF Y

08.400%  53.73mS/m
8.25pH 43.64mSn
63.43°F 20,86 tdspet
30.07inHa  33.35354l
41°3948.6'N 26,45
1°2836.1"  349.70RP
g SAMPLELOGGED ¥

Log

felect the logging type

“|0ne sample| Continuous
[ — Selact the log lot —
Lot2

Lot3

Lotd
kﬁ.IEﬂ:El;.-ﬂ_

=EE A8 5
g ve +

-~ %

Lot1

— Logging of one sample —
Enter remark

Add remark?

L Yes | Ho |

4+ | 0K

+ GPS7} AFE 7Fseti, 71717k S A9} Qg o] ot
S gAAAE B AQUT NRE FL ol
EASHE G2E FAA) 9AE Heb) 98 Yes>E
TEAANL o] FAE AUHHY <No>E TEAAL.

A% 24 BEh A8 H3 GPSTF bsE 49,
"Do you want to switch OFF the GPS unit after the
first sample to save power?" o]@ HA| X7} YEE
AdUth & Faol A AEAQ 27 B, Yes>&
=9 A= AS aFdH
"N"(North, or "S" South)¢} "E"(East, or "W" West)
FA17F "H"(Hold) Bjz19k WzZo} GPS x4l 7HA
B APyt
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Lape Lod

Add location?

| Yes | Mo B

Loti
o0 you wank to switch

OFF the GPS unit after the
first sample to save




98.400%  53.73mS/m | 98.400%  53.73mSkm |
8.25pH 4364 mScn 8.25pH 4364 mSfcn
65.43 °F 26.86 hdsppt 65.43°F 26.86Ldsppt
30.07irHg  35.555al 30.07inHa  35.55%5al
41°59'48.6'N  26.4% 41°59'48.6'0 26.4%
71°28'36.1"w 349.70RP 71°2836.1"0 349.70RP
SEEEIITE Logging... Logging...
270 W& W, GPS7H Ao Al Ad AU,
+ "Tag reading" 42 AEZS a2 AAA Y}
"Touch the tag with the tag reader" WA X]7} Tagreading
shwio] WSUrh o & Zbsd sk gl o
eSS AYHE W <Skip>S FEAA Q. Touch the tag with the
- BIE TAE AgE ID7F skl thebd R tag reader...
o] A3d ID7F §lod Alg]d A7 By th
AR HIE A AR g =g Agss g |

<Tag ID>Z F21 YA <OK>E FEAAL(ZFL
El2 Dol #A o] glttd 7Hds] <KOK>E FEAHALQ).

Note: remark®} ¢ (GPS7} ¥& Rl qvhz 27 g2E7 ojud SH3 27 Ao
adE = A5 ol 21{— "Log data setup" ¥9& HAA L. o7
o r Eolrtyd ESCE FEAY 27 43 985 T8 Hoﬂ AL w2
AxUTh A&AQ 27 A9 dolg Fo] A gAo]l FHE F Az
AJUrt. & 74 AE 27 S 98] <Log>7F B F dlolg 7} W%MD}.

271 HolE HA

2 EE A3 remarks YJEs 2% HolH :

Zo A% A dolHE U] By REES A4y Menu

W3l Wil "Log data" &4& MBI, <OK>E

o BRI ;Ieasuremenl Lelup

ystem Setup
Calibration

2E W 0K

o]l gHLe MR ZE st A, EF dolHu ' !

239 SAHE He 3, REE A A - L0g datsg —

583t

CSAE S Asd dste wes ddstan ooF | |poiete alllots

FEAAL. Delete all remarks
W | 0K
s 2E ZEE WHEHY New lot> AZEY|E F2a1 5
AR o) FS Ay g8 RS AgaaA e, | —Uatalots ilreerTUWA) —
S4E A <OK>E F2AA L. =i

Note: 3 9% A 2g ol YFo] 7153 T
W52 HAES HolFyrt)

ol E 59| "Data lots (free: 100%)" *| MWewlot | 0K |
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+ <Options>E F& A9, U 7|s50 34 &
JEYTH "View" AdlE 2Eo AFH =AHX H7I;
"Plot" Z]Z o 4-&8t= ZF; "Delete" A8EH ZE
AbA).

Note: 3t91 ¢]&e] ZE o]Fo] FAIHU.

« "View" A& st AE A AFol el B

A
ARESHAALS. AE AR )

B,

Note: JAIANES AHE7FsE 5ol et o] & 7Fe gyt

Z 7, Azt A remark, $1A(GPS7F &=

2doqmel Bl ID F& Algd Aol g 7hs
A5 17] 98 <Info>E E’/\l)\]o

«old sfHo R Eolrly] 98 <Data>E FEIiL e
REA t& HAES HdYstr] $s) <Jump>§_—
FEAA Q.

Jump>E FE o, 93 AT 24E 4Hs] A6
Y AE ukA7E UERE U

« "View, Plot, Delete" Wl'F= Fol7t#l¥W ESCE
FEAA L.

Plot

« "Plot"& A¥std Hdeed
Y2EZF yepd Adyth

- dote S AdYsteY SR 71E ARE sk Al Q.

IYPEZE B OK>E FEHA L.

« R 7S AREE LHZoll A AME FHola HE
stolgtol E RAIE YT AE tlolE 7t 1 offo
Byt

o zﬂ-E E]J\EE 50]-7}1':‘3]”4 ESCE EA])\]O

« "View, Plot, Delete" W72 Eol7l& W ESCE tHA

-
FEAAS
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e

Loki
Samples: a
Memory usage: 1%
First: 1500202008 09072
Last: 150252006 03:08:42
o | Oplions |
Lokl
View
Plot
Delete
a [ OK |

L%

7.06pH 2176 p5iom
=3.3pHmY 2138 p3/d
240870 1083t d=ppm

1.1135al
0.000%
000 DO0pemn

El__Info 1

-
b

¥,

Lot

Fem.:
Tag:

Sample:
010172005 114448

34

Femark 1
N0000e1 16365

Lote

Jump to sample

.+« | 0K |

-

—_— Heaiuremenl to plot —

A

-

m"n" of pH input

‘

¥3.38°F

§12/01/2006 08:49:02 AM




Note: 3t == A= 2E HE2 a7t #4142 5 dsdh

Delete
e "Delete"E AMEEH 3Ho| "The selected lot will be erased!
Continue?"7} B AJYt) 2HAete ™A <Yes>E F23L o] % || The selected lot will be

Lotz

o w Solrlew <KNo>E F24] )\] o erased! Continue?
« "Log data" W2 Eoprteul HEAoR FEUL | TR

EFE ZE 2HA|
» "Delete all data" ¥A°] A& =™, 3}bHo| "All stored log data will be erased!
Continue?" WAA 7} U}l AHAsEE <Yes>E F23 o)A sfHow Zolrtyd

No>E FEAA L.

Remarks
remarks ZF A& A#E o d& F Ao 7]1717F 20709 remark7bA] -8 T
» remarksE U3 W "Remarks" 540 RS A-8-5}0]

stolgto]lE AIE dhal KOK>E = A9S g3y

Select vemark

Remark 2

L Hew | Delete |

>

« J2E remarkE HEHHE Newd>E F2i °HAE

up2sh e AU 217 ARES gl sk

— [elete all remarks —

All stored remarks will
be arased! Continue?

remarkE F43EH W <Delete>E FEAHA L.
remark’} EA5HE ZEA] ALSEHW AR} g Teos — Ho |

2E do]g Atolo| Al ofHd3] o]&d APt ) g
Note: 273t= 52t 2t SHA7F Aeg ol e FxH gxE =
Add F dFYH

rlo
=
poauy
i
~
D
8
ab)
=
al
2

r{n

Remark 2HA]

o BE EASHE remarkE AHAlEHE Y S AEEy] 913 stai 71E ARESHAL
COK>E FE24A]2. 3ol "All stored remarks will ve erased! Continue?" WA %7}
1Y AdUth AAlsted Yes>E F2iL ol How Foprteid <No>&

H-L

B $17]

B Z2 A2 B2 IDE I dEE AR Bk WS $la] "Read tag"
s Agsia e
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| ags Taginfo
Tag §/N:
5."H =10 000ooDO2867F1
1D =+ 5/H Tag ldentifier:
Add tag manuallu My ktaglD
W F| Modify |  OK |

3} ol "Touch the
B gz B1E g5y

« Bj7F A W 7)7] st B Al d

« A4 B2 DS U
EEAAQ.

s Hl2 ARE 8] Y8l <Modify>E +

S/N—ID

of FAL B Al xAbeh Av

D Z:=&

_28_

tag with the tag reader” Uﬂ)\lxlﬂ B 717] f1%el 914

xAHek ID(e]&-7Fs
&t7] 918l <Tag ID> AZEJ|(Bf17} S1¥ A &2

o]
H

ahehu)7h BT

— N —
Enter tag 5/H

B EL T []
« "S/N-ID"E AEati <OK>E FEAAL.
« 7171 71REE AFEE AlEE wAE fJEEa KOK>E

I \ﬁ--ﬂ_
cH AR ARSI UEhg AU o suow

Eol7lHH <OK>E =23 "1 IDE WA HYE <Modify>E FE4A L.
Note: 948 % S/No| HlEg o A=A &2 29~ "This tag S/N is not stored in
memory" 73l WA|A] 7} YERG U T
ID—S/N (—— I+ I ———
o] FAE D¢ AHE B AlYd AE Holsyth Enter tag ID
+ "ID-S/N"S AEEka <OK>E F2AA L. [] |
» 717 VIREE ARES] ARE] mEE et

OK>E FEAA Q. (&« | DK
c B AR o] UEhd AUt old FHuow ‘

Zol7b7] 93] <OK>E F23 g1 IDE HAseW U+ 5H

<Modify>& FEAHA L. This tag 10 is not stored
Note: 98 % D7} w&Ego] glow A %] 7} in memory

JER U,
ﬁ [ 0K |

TELE B FE)
s 4o o888 F glSAgdE ID =7 1o dAdd = AFHTh
s dEre FAE dEdal KOK>E FEAA L.
« 7171 71REE ALEE] Bl AlElE =AE YEsta <OK>E vFE YT
« 37t Blae] ID =2 ]¥aka <OK>E FEAIA Q.



« 71717} el W fJEHE RE JHE BoE Ay
Bl o2 2bA

Bl w27t e E] AbAE S dFyh

« “Clear tag memory" A& AEsli <OK>E F2AA L.

» “All tag identifiers will be erased. Continue?"™ A X7} YElE Yt}

- B P

Tags ————

— [ lear bag memoary —

SH =+ 10
10—+ 5%H
Add tag manualiy

Claear tag memurg

L - .

All tag identifiers will be
erasad, Continue?

« Bl 2HAE FAHSHE Yes>E 72 o|d slHo=w =
« SA BER Fol/teW ESCE WHE Aoz FEAAIL
GLP dHl°]g

GLPx Z=H A #3 dolHE e A3yt
o] 752 T WA HAAE S “certified data"(GET &
E HE, )¢ ddEg o

GLP dlolH & AlZ3tstr] s 54 EE=oA <Menu>
AXEJE T2 oty R 71E AHESEe] “GLP data"
o4& stolgtolE A Y

Note: 14 dlo]El7} A stefulejo] Abg7bssta e

3}Hol “No GLP data available for this measurement"
HAIA] 7} BAUT KOK>E B¢ o4 spHo g Eolziyu)

Probe information X 2H A&

e X2 H AKWE H7] ¢8| “Probe information" &
}daﬂg} OK>E E/\] )\] o

« Th dolg 7 YEpEY T 2E FH e

« ol stHo R Eolrbr] 98 <OK>E F
WA 93l <Modify ID>E FE4 AL

« Modify ID>E F& 4§, g2E drxav} HLEHM =3
A3} 8}1 FA4st7] 918 <OK>=

o] Yo #H ESCE FHUth

» “Storing data on probe, please wait..."¢} "Data
successfully stored on probe" W AA]7} vFeERG U T

o2 Foprted <OK>&

A

filo

o] B1H, IDg} Ale]d
FEAY ID Z=E

» “Probe information" 3%

-
FEAAS
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ol7teH <No>& FEAHA L.

Menu

Measurement Setup
Syztem Setup
Calibration

LLP data N
ﬁ

-

-

—GLP data ———

Conductivity
Atmospheric pressure
ORpP

r

—— LLP data —

Mo GLP data available for
this measurement

— P data
‘

I]lssnlued CRYJen
Conductivity

— Py e information —

Model HI 769828
FW version 1.0

[1]
Serial number 00000

L,




Note: ¥zu7} A4s o] 97| sbrf A7 WA 7}
Jer

pH
« "GLP data"wl¥roll Al “pH" +

-
FEAAS

« At pH BAo| #ate] RE dlo]g7F YebgYth:

AE AEsta <OK>E

i

—— Probe information —

Probe disconnected:
procedure abortad!

p

A

(P T —

Dffset: —8.4mY
Slopell: 57.9 mY/pH
Slopali: 37.5 mY¥/pH

_ Buffer;: 7.01 {H)
QIEA A LRIE V)R S£RXALEE By, dAfe
A Ak g=, 7l =, AR o, At §15/02/2006  09:53:0%
A GRt
« Ak B 570e] AgE dolHE ~2aE5] 8l SR
J)= ALREA A0 GLP D0 ————
“] Hoh4 l Point1: 100 %
« “GLP data" "y 2 Eol7t#H ESC%— TEAAQ. Point2: 0% |
Note: B]¥ 3zt 7}7ko]ol] "C" g#lo] wt& XQEZE 7lg7|x .
H]—Ui] uHu]__; 61—]/}' Z %k 7}_12]71:]]/]]:]’ DOQ H‘]}_H7}_ Sitlll'-il:lnn{m
bt - v §2006-02-15 02:23:03
BAE u =3 DO % HY/F HAEHY O Jors
BAHEUT DO BA4o] =R o, i WA A7}
Uebd Ut <OK>E =8 oA sldoez Folziyt)
Conductivity =%
« "GLP data" ®l¥olA] "Conductivity"AdS Aelsta LLI" data
COK>E FEAA Q. o] HiFfs Axx, Az Axisl Probe information
= = = F“
A= HA W delH g Rojsyn Dissolved oxygen
« At AT BA B3 BE AHIF Vebdyth BA nndu{twltu
XQAE A AL B E(HAEE, AAY ARk, d%),
A Gt
—— LLPF conduckivity — LLPF conduckivity —
Point: &4.000 m5/cm Point: 5.00 m5%'cm
Cell: 5043 I Cell: 4.284
Actual conductivity Conductivity (H) |

d 15/02/2006 04:58:0%

& 15/02/2006

09:50: 19

« At 5719 A AL ~23E357] Y AR

A

salinity
Note: A=l HA 7p7to] "C'7F B ERIEE 7hel7)e whd
ZHEIAYY AR BAo] s o 4, il
o g Eoprtey <OK>& FEAA L. ddd 1

"Factory calibration"& X5t}

_30_

g A,

BAS 98] t2 3tHo] o] 8715yl conductivity, actual conductivity,

uHuL 5}_]/}‘ _J_Z zd\,v__

A A 7 dergd e o)

Aol F WAoo, 7|77}



Atmospheric pressure 7]+

+ "GLP data" H¥olA "Atmospheric pressure"&A
<OK>—E‘ =2 Al )\] Q.

I 718k A #ek BE JHIF YR Y 9E 1A

FRIE, A @A

1=
33 Exé o] Al AF=™ 3}H "Factory calibr. restored"

Aelsta = GLP atm. pressure — |
Factory calibr. restored ||

o

N

@ 15/02/2006 02:38:46

« 57HA AFE RS AAEs7]9E SR 71E AR SHEAI L.

Note: 7]§F ®AGo] Fa= A &2 A, Al WA A7} deEpg YT} o] o=
Eo7b7] 918 <OK>& FEAAL. A8E HAo] 374 Aol 77|17} "Factory
calibration" WA A& HojFU T}

ORP

« "GLP data" "%l A "ORP" &< A¥sti <OK>E LLE UHP
F actory caliby. restored

FEAA L.
« Atk ORP BAC #gt e AR7F yepgdych BA ¥Q1E,
Az g
o ¥4 RAo] A A= sHol| "Factory calibr. restored"
H A A 7} B QU T,
« 57HA ARE BAS 2AEsH9E MR 715 AFE S L.
Note: ORP H.A ] T?‘EE]X] > A5, A wAAZE PR U ol o R
Zo7b7] f18 <OK>E FEAA Q. A89E BAo] &4 BAed 7]7]7F "Factory
calibration" WA A& qu ISh=

§ 15/02/2006 04:05:34

Temperature &%
« "GLP data" "l4rollA "Temperature" A& A 8slaL — LLP temperature —
OK>E F2AA 9. Point: 5.00°C
« A 2% BAC #ek BE FEI YEpdUThE By ¥Q1E
Az g
c 5714 AAE WAS 36798 HAE 72 B15/02/2006  09:47:15
/\]_35}/\1 }\] Q.
Note: &% HAGo] Fau A &2 A9, Al WA A7} depg YT o] o=
Eo7b] 98] KOK>E FEAAIS. A¥s HAo] 37 ®AgolH 7]17]7} "Factory
calibration" WA|AE HolFUT,

PC 944 »:=

219 dolg Zglo] Hi ofZg Aol AT ES o] HI 929828 Windows®E AH-&-3f
PCE A3 4= 9%k

HI 9298282 ~XHEAE X209 gy A& FY Ul Excel®©,
Lotus 1-2-30): Ael® AZg=AE T2 oA HI 9298282 thez2= H vdS
A Ea A ESoJ(o: graphics, static analysis )2 Fusrt 75 4

rob
olf
tlo

|
=

lo

AR
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%y
o
Y

t}h HI 9298288 thkdl 7)< Alg-stal ojw sl Asto A A &AE A Pat=
Eeds Aledd.
Pl

+ B

5

A]

il

MZo GPS 2o & 29 HI 9298280] Aso g Auly MZ gAEo 7uke
2 AU A8 Google™3} & GPS 3% ~ZEd S S4o] s34

| 9is) APk o] 715 AHgaty] A Qe Adel sy,

o Ml T orfo ¥0
ki

o

i
[
N

I

AL E O A

« CDE PColl Y54t

« 2ZES] dp ATt Abs 0w AU RA efor H<Ql CD EHel 1A
"hi929828start.exe"& CIEEE YT}, "Install software"& E835tal A A|AMES

EAHA L.

PC 94

e 2% 770 ZTEBE AU}

« HI 7698281 USB ©J§lE]& 7]7]¢} PCol %+ USB X Eo| PC connection
AATA A L.

« 71712 #AW "PC connection" WAIX| 7} YEFEGU T} g  Menu | |

« HI 929828 olZ Aol AT Eo]S zH5A]7]aL, "Settings" ©
A5 ot 9= COM EE(SL "Automatic detect” FAS
ALgEH A 2) 9] 5 A EE I "Connect"E FEAAQ.

 HI 929828¢] Z1% HoJEE th=2= Ul PC RYE7} Sending lot...
GLP dlo]H ¢} 29 2EE HoFUL tersol ZE
RE AMZS w7 93 A= ZES HEsta "Get lot" AL g3 N

— Hame of the lot —

A FEAAL.
s GRRESE 59, dEE dlolE HAES AIZFAQ AV st H YTt
Note: 7]7] AZd& ¢lal PC COM XE 25 W73stH W, HI 929828 "Settings" %=
okl "Detect Selected Instrument" &S FE2AA| 2. ¥HH, Windows® B 227 Hfof A]
STARTE F23 9l df7olA "Settings"S A8 3}aL Y34 "Control panel", "System",
"Hardware", "Device Manager", "Ports"& A &gy}, o] vlx@ w7+ USB Al8| <Y

S Ed 7M7hE COM X E9 & HolZHFUr}

o2 wAA
HI 98288 = 2H} 7]7] olgj7} YA WA A Agj=71 e Jepdyoh e 7ts
L ol A wE ARE doyd "Help" HES =8 o]& 753yt

» "Continuous logging— Flash memory is full": WX2& 7} & — Lontinuous logaing —
al

A3 H ol 54X mad F gl OKE FE
dht B 1 oo REE AAFL

Flash memory is full
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» "Flash memory error!": 7]7] WH2] w2 ] o7}
AFY T

COK>E F23 fojE2 genssy RE 2E2 Abg s}

FAZE JEE S A2 ] dgtehiAle.

» "Probe communication error!": 2 H &} 7]|7] Alo]]
AxYA A A7 AFUG AolEo] HEs| A4 Lo
AEA Belstal 7715 £ F TR B E At g

A
dAdUT ZAZE slew g Auls AlE ol dEtet AL,

* "Probe critical error: EEPROM corruption!": 22=H
EEPROM tlolEdl @#F7F syt 71715 1131 ZeH 5
s|AIBEAL thAl AAFAA L. EAZE JoH gt Au] A
Aol AztaliiAl 2.

"Probe critical error: ADC blocked!": =2H W& A/D
AME7F g4 AW T dFUTh 7I71E 113 Z2HEE
A AL ThA] AASHAI L. FAZF Yo F AH|
AlE o] Agtat Al 2.

» "Probe critical error: 12C bus fault!": W3- ddo]
AR FAY A olx] e A EHFHT & WA
ZEZF A=Y 7718 113 Z2HE S|AEa thA|
AASIAA Q. wAZF Jo S U] AlE o] S A L.

« "Probe critical error": 34 <Ql 2 H o7} dojdt}
71718 1131, ZR2BE | A5ta A A AL, A7t
o s Mu|=AlE o AgsiA Al Q.

» "None of the enabled measurements is available": &3}
AA7F 2B A AlZFetA] eF7] Wit deE i T g
7HA & o] §7HsskA et o] WAIA| 7 S EE
el 71712 13 e E AAE Axsta A AxE

g

» "Please disconnect probe from meter before installing or
removing any sensor!": 7|7 A A}&2}7F AAE A A A Y
AlApstal 22 B7F AZAEW o] wAA 7 YEPE Yt Al
z2H 245 93] e Z2EE o3t 2H5S 42357
Aell 71715 |4
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— Lontinuous logging —

Flash memory error!

Probe communication

error!

& | Menu |
Probea critical evror:
EEPROM corruption!

i [ Menu |
Probe critical ervor: ADC
blocked!

& [ Menu |

e
\,

Probe critical error: I2C
bus Fault!

Probe critical error!

Hone of the enabled

measurements is
available

Please disconnect probe
from meter before
installing or removing
any sensor!




* "Error-Valid sensors config. is Temp, pH, ORP, Cond., DO, Error \
Pressure" 5 FAFSE WA|A]: A}§27F EAjehs 2E QoA

Yalid sensors config. is:

e A AR 2e AES )SP 2& RE ko] || Temp,pH, ORP, Cond., 00,
Pressume

e "Error-Current date and time precede the last logged

Erroi
sample!": A}&A}7} EA3t= RE etol A A28 dolH Current date and time
A%g @ AdAw 7179 @A) A It A precede the last logged

samplel
2EAA Ay 2w delEe] A wAE

. s o - - _|d 0K ]
OK>E w21 AIRFY I 52 08 2EoA 270 Bk
e AR L.
*+ "12C bus error!": WH-AQl HEFo] QA A A g4 o] 4]
oro i Awe] EX 2 7|72 113 thA AUtk BA47} I12C bus error!
AL gt A H| 2 AlE] el Agkshi Al L. g Ok |

=

« "GPS signal not available"(GPS7} 7158t ®dlof| Agh): GPS | —— LP3 diagnoshics —
FAZE FaskA FEUh Ae] e A2 & 16w
7ok A A S
LA ASEH, g Ar]2 dlE el A [T wpsorr | ok M

GPS signal not available

~

[ — LIPS diagnostics —

» "Communication error with GPS unit"(GPS7} & Ed):
e o) 2= C icati
g% GPSsh ARUAelde] QAwE 5 g SIS MK D
N7 298 1A BA A F OA AESPA L. EA7
AgHw e W 58 7o e oha axgyy, | IEEE .
FA7E A& gt Auls A6 AgalilAle.

xZ2H §X
HI 9828 HI 7042S(H43 €9 DO
A AAS fg 22 5, AA A2

FANE E33 228 {4 7 E9t 9 Al

F ZRRE FRER TR ARAIYT pH AF AT Fa A8k g
E

A Zen RS 98 REge 2gvit wAs gL b & wAY A
A
o AR mhEAAe
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iy
Hm

el
-

==
1o

el
-

;i

i

ARG defd oz tAl A

s
s

el
e
;i
= &
| W

5 3
™
op ok

™ o
By m

st AA

S

9/]

==
T

g2y whelo

ol

K

H4

S

lHe A=z

.

A

]

—
a

)

o]

a

.

mobx] hAAL S, o] pH Aol A

U
171 9l

I

of

o)
H
ol
ol
°

al

A

]

£

Ape}

i
$ AN 34

==
T

A HI 70300 A% &

©

o) Az

doln &8 o]
i

2nel §4
0.

Fut,
- AT A

pH

T

« HI 70300 A%

ZH A

=

d] %_oﬂ

&
=

HI 70671 Al
— 35 —

[e)

=

171 el 0-%

©

X2 HE HI 70670
A

A =}
= oA

=

Al

A2 pH A AFE A3 SFFY 2 o€ AR vHAL.

EC Z2n9 &4

o
. /ﬂl/\ll



